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1:  PROGRAM DESIGN AND IMPLEMENTATION





1.1:  CLASS DESIGN



The classes involved in the program are:



1)  cd - class representing a CD, adapted from Part 1.

2)  collection - class which manages the CD collection, adapted from Part 1. 

3)  Server - class which acts as a dedicated server listening for clients and setting up threads.

4)  ServerThread - class which implements client/server protocol for a single network connection.

5)  gui - Graphical User Interface Client.





Figure 1:  Diagram showing the classes involved in the client/server program.
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#  -  indicates a class has been adapted from Part 1.



This diagram clearly shows the 5 classes that make up the program. The arrows indicate which classes use object instances of each class.  The access permissions have been designed accordingly. 





1.1(a) Class overview:



cd class:



This class was designed in part 1 to model a real CD object and to store a set of private fields representing the data held on a CD.  It was decided to place the cd class in the both the Client and Server package, because that the Client needs to be able to construct a cd object during the Add operation..  This class has been modified to include one additional field in which to store a URL address of an Image representing a CD cover.  This field is held in the String cover_URL which has access restricted using the ‘private’ modifier.  External objects can retrieve the URL String by accessing the public getcover_URL() method which has been added to this class and which returns the String to a calling environment.  This class also has a test main which can be used to construct an object instance of the class and to display it to the screen in text format.  This operation can be seen in the testing section of this document (2.1).



collection class:



This class has been modified from the ‘collection class’ designed in Part 1.  In Part 1, this class contained a main method from where the entire CD program was run, but this has been replaced with a method called processInput().  As before this class manages the CD collection and contains all the methods developed to access the collection held in a Vector of cd objects.  These methods have changed very little from Part 1, but have been modified to deal with Server protocol and to handle  the reading and writing of object files.



Server:



This class is the connection to the network and contains the only main method (program control) on the Server side of the system. It sets up a ServerSocket to a designated port and ‘listens’ for incoming Client connections.  When a Client connection is established it constructs a new thread (ServerThread) to handle Client/Server protocol and continues to listen for Client connections.  This class was designed to achieve a multi-threaded Server design simply and efficiently.  It also means this class is not committed to a CD Server program, but can be used as a multi-threaded Server for any application.



ServerThread:



The ServerThread class was designed to implement Server protocol over a network connection to a Client.  An instance of this class is constructed within the main method of the Server class.  It is constructed with a socket connection to a client already established by the Server class and is responsible for running Client/Server interaction over the port.  It contains two methods;  run(), which contains the dialog loop which is the area of control responsible for receiving data from the Client, and sendObjects() which as expected is responsible for sending data to the Client.  This class has been designed to interface between the collection class (which it constructs an instance of) and the Client.



gui:



This is the only class involved in the Client end of the system.  This class is by far the largest and most complex class in the system, being responsible for constructing a GUI and for implementing Client requests to the Server program via the network.  It contains a very simple main method which is the where the Client program is run.  This class is used to set up a connection to the Server and to 

construct an instance of gui with these connections and then display the GUI to the screen.  From this point the control remains within the instance of gui (g) which reacts to action events. 









1.1(b)  Class description:



cd class:



As described in Part 1 but with the following additions/changes:



String cover_URL	this hold the URL of an image representing the CD cover.

getCoverURL()	this method returns the URL String to the calling environment.



collection class:	



Vector CDS:		contains cd objects representing a CD collection.

Vector theOutput:	Vector used to package cd objects for sending to the server.

String default_file:	contains the identity of a text file representing a CD collection.



processInput():	



This method replaced main() from Part 1.   It is called from within  ServerThread and is used to implement all the commands sent by the Client.  It carries out Client requests by calling the methods in the class to carry out various functions, it then returns the Vector theOutput to the ServerThread program.  This Vector will either contain cd objects or will be empty depending on the Client request. 

 

addCD():		



This is the only method outside the control of processInput() within the collection class.  It is called from within ServerThread and is used to add a cd object sent by the Client to the collection Vector CDS.



Search():		



Search() is a powerful method in that it can process 5 separate requests:



ARTIST

COMPOSER 

TITLE 

TRACK

REMOVE



It achieves this multiple functionality by using an integer representing the type of request it must carry out.  Search() was designed in this way due to the fact that all these operations require a common searching strategy.  It was therefore felt that to repeat this would be inefficient. The integer is used to operate a simple switch statement to execute the correct operation when the required item is found by the search loop.



List():	



This method is used when the client wishes to refresh the collection list in the GUI window following a search request.  This method simply assigns the Vector theOutput to the current collection (Vector CDS).



Load/Save format:



The program has been modified from Part 1 to have the ability to save and load files containing objects.  These object files are generated by using dedicated objects embedded in the Java API which are capable of file/object interaction.



The program is, however, designed to initially load a default CD collection stored in text format. This allows the default collection to edited off-line using a text editor, making it simple to change the CD collection.  From this point onwards files are loaded and saved in object format. 



loadCollectionText():	



This has remained essentially unchanged from Part 1 and is used to load the text file (cd_url.txt) representing the default CD collection. The only modification is the ability to cope with a String representing the URL of a cover image.    



saveCollection():	



This method is used to save the Vector CDS to a file as an Object.  This is  achieved using a FileOutputStream connected to an ObjectOutputStream. 



loadCollection():		



This method is used to load a file using a FileInputStream connected to an ObjectInputStream.  It loads the object files created using saveCollection() and assigns the Vector theOutput to the file object.  This Vector is then returned to ServerThread which sends the cd objects it contains to the Client. 



Server class:



main():	



The program sets up a Serversocket to port number 5421 (allocated port).  The while(true) loop then continuously ‘listens’ for a Client connection to the port.  The accept() method takes a Client connection and initiates a new thread by calling the start() method and creating an instance of ServerThread.



ServerThread class:



run():	



This method controls the communications thread of the Server to a particular Client.  It sets up an ObjectInputStream and an ObjectOutputStream onto the socket connection established by Server.  An instance of collection is constructed and the default collection is then loaded via the loadCollectionText() method in the collection class.  Control then falls into the while() loop which sends the objects send by the Client to the relevant methods in collection to be processed.  The processInput() method in collection returns a Vector which may containing cd objects.  









sendObjects():



This method checks the Vector sent back from collection to see if it contains any cd objects.  If it does, the String “SENDING” is sent to the Client followed by the individual cd objects.  If the Vector is empty the String “NOT SENDING” is sent to the Client.



gui class:



In order to make the description of this class clearer, I will  not go into too much detail concerning the construction of the AWT components. 









Figure 2:  gui class structure.



                      class gui

�

                         CONSTRUCTOR:	Constructs Window using AWT components and is passed I/O objects from main().

 

                                     METHODS:  To help process I/O and other repeated functions.

�

��                                     ACTION LISTENER():  if (action  = SEARCH or ADD)   construct SearchAddDialog;                  s_dialog

�

��                                                                             else if (action = LOAD or SAVE)  construct InputDialog;                          i_dialog

                                                                                    

                                                                             else process locally; 



��                                                

�                                         MAIN():  Sets up I/O objects, passes them to gui constructor creating  instance of gui (g).                g

              

                                                           g.show();



                                                                                                      

� 



                                          SearchAddDialog:  CONSTRUCTOR:  Dialog constructed using AWT components.

�                                                                            

                                                                             ACTION LISTENER():  if (action = Search or Add) process;

                                                                                                                      else close dialog;



�

                                           InputDialog:  CONSTRUCTOR:   Dialog constructed using AWT components.



�                                                                    ACTION LISTENER():  if (action = Load or Save)  process;

                                                                                                             else close dialog;

�



                                          cdCover:  using the paint method of the Graphics object an image is drawn on a Canvas.













�Key:	class		

�	object		

�	main()		 







A CD Collection GUI Client is such a specific application that reusability of any processes involved seems doubtful.  It was therefore decided to design a single gui class consisting of inner classes and methods that would be responsible for all client operations.





gui contains three inner classes:		



1)  cdCover class:	



This class extends Canvas and is responsible for placing an image of the CD cover onto the main GUI window.  This class was designed to encourage reusability and to keep the program structure clear.     



SearchAddDialog class:



This class extends Dialog and is used to produce a dialog for the ADD and the SEARCH function.  Both these functions require a facility to allow the user to enter all the individual fields of a CD so when designing dialogs for these functions it seemed more efficient to reuse the same dialog box.  The only difference between the two dialogs in the extra TextField in the ADD dialog used for entering a URL of a cover image.  An actionPerformed method is also in this class to process the TextFields entries.  This class was designed as an inner class of gui because it was felt that it was specific to the program and therefore did not warrant higher class status.  It was also decided that putting it into an inner class aided clarity and improves program structure. 



InputDialog class:



This class also extends Dialog and is used for the LOAD and SAVE functions.  Again this design was adopted for reasons of program structure, clarity and to conform to standard dialog use in windows programming.





gui methods:



position():	



This method was designed to improve program efficiency by carrying out the repetitive function of positioning the AWT components using the Grid Bag Layout Manager.  It uses methods of Grid Bag to achieve this. 



displayTitles():	



This method is used to display titles of cd objects that are sent by the server in the cd_choice List that appears in the main GUI Window.  It achieves this by accessing the String representing the CD title using the getTitle() method of the cd class.



displayContents():	



This method carries out the task of displaying the entire contents of a cd object in the various components in the main GUI Window.  The CD title, artist and composer are displayed in the TextFields, the tracks are displayed in the track List and the image is displayed in the Canvas (see GUI diagrams). 



processObjects():	



This method was designed to cope with any kind of response sent by the server.  It was designed to remove the repetitive process involved in reading objects sent by the Server away from the Action Listener methods throughout the class.  This improves program clarity and efficiency, and means that all Client input is localised in a single method. 







1.2:  HOW THE PROGRAM WORKS





1.2(b):  Client/Server Analysis



Client



gui class main():



A Socket object is set up to the designated port: 5421.

ObjectInputStream and ObjectOutputStream objects are then set up on the Socket object.

An instance g of the gui class is constructed, passing it the I/O objects attached to the Socket.

g.show() the makes the GUI constructed in gui using the AWT components visible on the screen.



g (gui instance):



The gui instance g is set up with I/O objects (ObjectStreams) and a title for the main GUI window.

Various instances of AWT components that are used to make a GUI are declared.

The components are positioned in the Frame using the Grid Bag layout manager (see GUI Diagrams).

ActionListener objects are then attached to the components, e.g. buttons.

The default collection of cd objects automatically sent by the Server is then received and processed using the method processObjects().

The main actionPerformed() method for the GUI frame then waits to process user selections.



Server



Server class main():



A new ServerSocket object is set up to ‘listen’ on the designated port: 5421.

Each time a Client/Server connection is detected a new thread is set up using an instance of the ServerThread class.



ServerThread:



A new Socket object is initialised to the Socket object established in Server. 

New object I/O Streams are attached to the socket object to facilitate object I/O.

An instance of the collection class is then constructed.

A default collection of cd objects is then sent to the Client using the sendObjects() method.

Control then falls into the while loop used to process Client requests via methods in the collection class until a null object is sent by the Client to close the socket.

The input object (a String) is processed in collection always returning a Vector.  If the Client request required cd objects to be sent back (e.g. LIST) then this Vector will contain cd objects.  If, however, the client request did not require cd objects to be sent back then the Vector will be empty.  The method sendObjects() deals with both possibilities by testing to see if the Vector contains anything.

 

collection:



The input String from the client is passed into processInput() method.

The string is then broken into its constituent strings and the relevant methods then called to process the client request.

A Vector used to package the cd objects is then sent back to ServerThread so its contents can be sent to the client.

If addCD() is called then a cd object is added to the CDS Vector.





1.2(b):  Client/Server Dialog





Client



Component			Event						Object sent to server



�



Main GUI



Display Button	Highlighted CD title in cd_choice list sent to server		“TITLE title”

Remove Button	Highlighted CD title in cd_choice list removed		“REMOVE title”

Menu - Load		InputDialog GUI customised for Load appears		none

Menu - Save 		InputDialog GUI customised for Save appears		none

Menu - Close		Program terminated						none

Menu - Add CD	SearchAddDialog  GUI customised for Add appears		none

Menu - Search		SearchAddDialog GUI customised for Search appears	none

Menu - Dump		Command LIST sent to server, text collection printed	“LIST”

Menu - List		Command LIST sent to server, cd_choice list refreshed	“LIST”



InputDialog GUI

		

Load - OK		TextField input sent to server to attempt to load		“LOAD filename”

Load - Cancel		Dialog closed

Save -OK		TextField input sent to sever to attempt to save		“SAVE filename”

Load - Cancel		Dialog closed



SearchAddDialog



Search - OK		See explanation below 				 Various

Search - Cancel	Dialog closed

Add - OK		See explanation below 				“sending_cd” + cd object

Add - Cancel		Dialog closed



Client transmission:



Display Button (see GUI diagram 2):

	

The highlighted title in the collection list (cd_choice) is copied and added to  the String “Title” to form a standard command line, e.g. “Title title”.  This is sent as an object to the server which processes the String using the processInput() method in collection.



Remove Button:

	

The highlighted title in cd_choice is copied and converted to the command line “Remove title”. This is then sent to the sever which again processes the request.  The title is then removed from the cd_choice list.



Add CD (see GUI diagram 6 ):



The SearchAddDialog window appears and the user then fills in the TextFields with the CD data.

When the user selects the OK button the TextFields are processed.  A check is carried out to determine if a title has been added.  The operation is aborted if no title has been added.  If a title has been added the rest of the TextFields are copied, a cd object is created and a String is then sent to the Server warning it that a cd object is about to be sent.  The cd objects are then sent..



1)  Object (String) “sending_cd”

2)  Object(cd)



Search (see GUI diagram 4):



The SearchAddDialog window appears for the user to enter desired search items.  Each TextField item is individually copied, converted into a command line and sent to the server for processing., e.g.



“Title user_input”		- from title TextField

“Artist user_input”		- from artist TextField

“Composer user_input”	- from composer TextField

“Track user_input”		- from track List



 If any of the search requests are successful the cd_choice list is cleared and the title of each returned cd object is added to the list.  If all the requests are unsuccessful and no cd objects are returned the cd_choice list is left unchanged and the dialog window is closed. 





Server handling of Client transmission:





The loop shown below is used in ServerThread to handle all Client transmission.  The Client sends two types of transmission, a) String warning followed by a cd object, and b) String request.  The if/else statement in the loop handles these and uses the methods of the collection class to process them. The method addCD() is called in the case of transmission(a), and the method processInput() is called for transmission(b).









while ((inputObject = in.readObject())!= null) {

   inputLine = (String)inputObject;

   if (inputLine.equals("sending_cd")) {

      if ((inputObject = in.readObject())!= null) {

         c.addCD((cd)inputObject);

      }

   }   

   else {

      outputVector = c.processInput(inputLine);

      if (outputVector != null) sendOjects(outputVector, out);

   }

}





Server transmission



The Server sends two kinds of transmission to the client:



1)  The Vector returned to ServerThread by collection did contain cd objects for sending to the Client.  e.g. successful Search, Load request, List request etc. 

	

‘Transmission’ sequence:



a)  Object (String) “SENDING” 		- start of transmission signal

b)  Object (cd)n				- body of transmission

c)  Object(null)				- end of transmission signal



2) The Vector returned to ServerThread by collection did not contain cd objects. 

    e.g. unsuccessful Search, Save request, Remove request etc.



‘Not Transmitting’ sequence:



a)  Object (String) “NOT SENDING”	- not transmitting signal





Client handling of Server transmission:





The Client uses the method processObjects() to handle all Server transmission.  This method takes a single integer argument - type.  This integer is used by the switch statement to process the cd objects sent by the server.  The loop shown below forms the basis of this method.  This loop handles both types of server transmission.  This method improves protocol safety, simplifies adding features and increases program clarity.



while (true) {   

   fromServer = in.readObject();

   String temp = (String)fromServer;

   if (temp.equals("SENDING")) {

      if (type == 3) cd_choice.removeAll();

      while (true) {

         fromServer = in.readObject();

         CD = (cd)fromServer;

         if (CD == null) break;

         else {

            switch (type) {

               case 1: displayTitles(CD); break;

               case 2: displayContents(CD); break;

               case 3: displayTitles(CD); break;

               case 4: CD.printAll(); break;

               case 5: tempVector.addElement(CD.getTitle()); break;

            }

         }

      }

      break;

   }

   else break;  // "NOT SENDING"       

}







1.3:  CONVERTING THE PROGRAM INTO AN APPLET





The program could be converted into an applet in the following way:



1)  Check all Input/Output relevant to the user goes through the awt interface.

2)  Remove all components and commands used to stop the program, e.g. System.exit() and Close options.

3)  Check to see if flow layout manger is compatible with applets default layout, if not change from Grid Bag to flow layout.

4)  Import the applet package (import java.applet.*; ) and change the main gui class to extend Applet and not Frame.

5)  Replace the constructor with a redefinition of the init method, which will be called by Applet to make one off initialisations.

6)  Remove the main method from the program, as the applet package will take over its functions such as creating a window and setting its size and visibility.

7)  Create an HTML file that refers to an applets class file or include HTML instructions (tags) in a existing web page.

8)  Run the HTML file through an applet viewer or through a web browser.



There are consequences in no longer importing frame. A call to setTitle must be removed and any other frame specific method calls must be replaced by Applet ones. 































2:  TEST REPORT







2.1:  TEST DESCRIPTION





System testing was achieved using a combination of both black-box and white-box approaches.



The testing strategy was as follows:



1)  The various logic gates and exceptions within the programs involved were identified and numbered. 

2)  These gates were then used to develop a series of black-box tests that were then used to test the entire system and all possible combinations of events.

3)  During the black-box testing the logic gates and exceptions that were accessed during each test were noted and recorded. 



Using this method of developing black-box testing using logic gate analysis means that the tests strategy is both powerful and thorough.





Class Logic Gates and Exceptions





The table shown below displays the logic gates and exceptions contained in each class.  For a more detailed view see annotated source code.







Class�Logic Gates�Exceptions��gui�1 to 41�A to K��cd�42 to  44�L to N��collection�45 to 55�O to T��Server�56 to 57�U��ServerThread�58 to 62�V to X ��



A total of 32 test were developed - see test tables 1 and 2.  Each table shows the test, the result and whether or not a diagram is available.  Both the Server (command line) and the Client (command line/GUI) results are shown if both sides had a response to an operation.  



A table showing the exceptions thrown during the tests was also developed - see Exception Check table.  



























TEST TABLE - 1











INTERFACE�TEST NO.�TEST�RESULT�DIAGRAM��������Server Terminal�1�Ran Server.java with all dependent classes and files intact.�Server:  "Listening for Clients...."  ����2�Removed default CD collection text file then tried to run Server�Server:  "++ERROR - File not found."����3�Corrupted default CD collection text file then tried to run Server.�Server:  "++ERROR - Default collection may be corrupted."����4�Changed port number to 80 then tried to run Server. �Server:  "Could not listen on port:  80"���Client Terminal�5�With Server running ran gui.java.�Server:  "Client thread initiated - thread count = 1"������Client:  GUI appeared containing default CD collection.����6�Ran a second gui Client on a new terminal to demonstrate threads.�Server:  "Client thread initiated - thread count = 2."������Client:  Second GUI appeared functioning correctly.�1��Main Client GUI�7�Selected a CD title from collection list and selected the Display button.�Server:  "Heard:  title selected_title" ������Client:  Image/Data fields appeared in GUI components.�2���8�As above but CD image URL was incorrect or image removed from file. �Server:  "Heard:  title selected_title"������Client:  "Image Error" (terminal) Data fields appeared in GUI.����9�Selected a CD title from collection list and selected the Remove button.�Server:  "Heard:  Remove selected_title"������Client:  CD title was removed from the collection list.����10�Double clicked on close icon in Main GUI window.�Server:  "Client thread terminated"������Client:  GUI terminated.����11�Selected Close menu item from main GUI window Menu�Server:  "Client thread terminated"������Client:  GUI terminated.����12�Selected Load menu item from main GUI window Menu�Client:  Load Dialog appears.����13�Selected Save menu item from main GUI window Menu�Client:  Save Dialog appears.����14�Selected Add CD menu item from main GUI window Menu�Client:  Add CD Dialog appears.����15�Selected Search menu item from main GUI window Menu�Client:  Search Dialog appears.�3���16�Selected List menu item from main GUI window Menu�Server:  "Heard:  List"������Client:  collection list in Main GUI is refreshed.����17�Selected Dump menu item from main GUI window Menu�Server:  "Heard:  List"������Client:  Collection in text format is printed to screen.���

�TEST TABLE - 2











INTERFACE�TEST NO.�TEST�RESULT�DIAGRAM��������Load Dialog�18�Selected Cancel button.�Client:  Dialog is terminated.�7���19�Typed "wrong file name" into TextField and selected OK.�Server:  "Heard:  Load wrong_file_name"������Client:  Nothing happens (nothing returned from Server)�7���20�Typed "new_collection" into TextField and selected OK.�Server:  "Heard:  Load new_collection"������Client:  GUI collection list is filled with new collection.�7��Save Dialog�21�Selected Cancel button.�Client:  Dialog is terminated.�8���22�Typed "save_file" into TextField and selected OK.�Server: "Heard:  Save save_file"������Client:  Dialog is terminated.�8��Add Dialog�23�Selected Cancel button.�Client:  Dialog is terminated.�6���24�Entered CD data into TextFields without CD title and selected Add.�Client:  Dialog is terminated request ignored.����25�Entered CD data into TextFields with CD title and selected Add.�Server:  "Adding CD"  ������Client:  CD title appears in list.�6���26�Entered CD data into TextFields with incorrect image URL.�Server:  "Adding CD"������Client:  CD title appears in list.  When selected no image.���Search Dialog�27�Selected Cancel button�Client:  Dialog terminated.�4���28�Entered a CD title in title TextField and selected Search.�Server:  "Heard:  title title_entered"�4/5�����Client:  If found list is first cleared and it is placed in list.����29�Entered a CD artist in artist TextField and selected Search.�Server:  "Heard:  artist artist_entered"������Client:  If found list is first cleared and it is placed in list.����30�Entered a CD composer in composer TextField and selected Search.�Server:  "Heard:  artist artist_entered"������Client:  If found list is first cleared and it is placed in list.�4/5���31�Entered a CD track in track TextField and selected Enter and Search.�Client:  The track is placed into track list and TextField is cleared.�4/5���32�Entered a combination of search items as above then selected Search.�Server:  "Heard:  field  item_entered" for every item entered.������Client:  If any items are found again placed in collection list.�4/5��Misc.�33�Attempted to run program without Server up and running.�Client:  “I/O Exception attempting to start program.”���







































LOGIC GATE CHECK TABLE - 1 



� EMBED Excel.Sheet.5  ���































LOGIC GATE CHECK TABLE - 2 





� EMBED Excel.Sheet.5  ����EXCEPTION CHECK TABLE





�EXCEPTIONS�������������������������TEST NO.�A�B�C�D�E�F�G�H�I�J�K�L�M�N�O�P�Q�R�S�T�U�V�W�X��2���������������x�����������3�����������������x���������4���������������������x�����8����x����������������������10������������������������x��11������������������������x��19������������������x��������33��x������������������������TOTAL�T�1�T�1�T�T�T�T�T�T�T�T�T�T�1�T�1�1�T�T�1�T�T�2���2.2:  TEST COMMENTARY







Files used to test the system:



1)  cd_url_test.txt  -  contains no end of data set marker.

  



Commentary:



As can be seen in Logic Gate Check Tables 1 and 2 all the logic gates were tested fully.  During each black-box operation the gates and exceptions that were accessed were recorded.  This resulted in the whole program being tested.

A ‘P1’ in these tables signifies that the gates were tested thoroughly in the Part 1 of this assignment.  A ‘T’ in the Exception Check Table signifies that these exceptions were tested and developed during the programming phase.  These exceptions were not then tested during testing either because this would mean changing the source code or replicating random system errors - both undesirable.



During testing the programs involved were found to be free of error. 

See the annotated source code for the location of each logic gate and exception. 





























































2.3:  USER GUIDE





2.3(a):  Accessing and Running the Programs



Access:



The address of my java directory is:  tao.cs/masters/98/wilkinso/java



In order for the program to function the following files must be in the above directory:



- cd.java

- collection.java

- Server.java

- ServerThread.java

- gui.java



The Server must be up and running in order to run the Client or the Client will fail to connect.



Running the Server side of the program:



1)  Compile Server.java by typing javac Server.java

2)  Run Server.java by typing  java Server



Running the Client side of the program:



1)  Compile  gui.java by typing javac gui.java

2)  Run  gui.java  by typing java gui





2.3(b):  User Instructions





Running  gui.java will  result in the Main GUI appearing on the screen (GUI diagram 1).



GUI Client options (see GUI Menu):



To Terminate the program:



1)  Double click the window close icon in upper left hand corner of Main GUI

2)  Select Close from the File Menu Item in the Main GUI Window.



To Display the contents of a CD:



1)  Select a CD title from the CD collection list in the Main GUI Window.

2)  Press the Display button.



To Remove CD from the collection:



1)  Select a CD title from the CD collection list in the Main GUI Window.

2)  Press the Remove button.



To Load a collection:



1)  Select Load from the File Menu Item in the Main GUI Window to bring up the Load Dialog.

2)  Enter a the filename of the collection (object file) in the TextField, then press the OK button.

3)  To exit the Load Dialog without loading a collection press the Cancel button.  



To Save the current CD collection;



1)  Select Save from the File Menu Item in the Main GUI Window to bring up the Save Dialog.

2)  Enter the filename you wish to save the current collection as then press the OK button.

3)  To exit the Save Dialog without saving, press the Cancel button.



To Add a CD to the current collection:



1)  Select Add CD from the Edit Menu Item in the Main GUI Window to bring up the Add Dialog.

2)  Enter the CD information in the TextFields.  The minimum requirement is to enter the CD Title.

3)  A tracks list is formed by typing track names into the track TextField and pressing Enter button.

3)  When all the CD information has been entered, press the Add button.  The CD is added.

4)  To exit the Add Dialog at any time press the Cancel button. 



To Search the collection:



1)  Select Search from the Tools Menu Item in the Main GUI Window to bring up the Search Dialog.

2)  Enter the items you wish to search for in the relevant TextFields.

3)  To commence a search press the Search button. 

4)  If an item was found in a CD the Title is placed in the collection list in the Main GUI Window. 

5)  If no items were found the collection list remains filled with the Titles of the current collection.



To Refresh the collection list following a successful search:



1)  Select List from the Tools Menu Item in the Main GUI Window.

2)  The CD collection will be displayed in the collection list replacing the search results.



To Dump the collection in text format:



1)  Select Dump from the Tools Menu Item in the Main GUI Window.

2)  The CD collection will be displayed in text format in the Client terminal window.







See GUI MENU for full user options.
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3:  SOURCE CODE









The following pages contain print-outs of the files listed below: 





Programs:			-  gui.java

				-  cd.java

				-  collection.java

				-  Server.java

				-  ServerThread.java





CD Collection file:		-  cd_url.txt





Test File:			-  cd_url_test.txt
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